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DISCLAIMER 1 

Certain commercial entities, equipment, products, or materials may be identified by name or company 2 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 3 
experimental procedure or concept adequately. Such identification is not intended to imply special 4 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 5 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 6 
for the purpose. 7 

National Institute of Standards and Technology Special Publication 1800-30C, Natl. Inst. Stand. Technol. 8 
Spec. Publ. 1800-30C, 160 pages, (May 2021), CODEN: NSPUE2 9 

FEEDBACK 10 

You can improve this guide by contributing feedback. As you review and adopt this solution for your 11 
own organization, we ask you and your colleagues to share your experience and advice with us. 12 

Comments on this publication may be submitted to: hit_nccoe@nist.gov. 13 

Public comment period: May 6, 2021 through June 7, 2021 14 

As a private-public partnership, we are always seeking feedback on our practice guides. We are 15 
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you 16 
have implemented the reference design, or have questions about applying it in your environment, 17 
please email us at hit_nccoe@nist.gov. 18 

All comments are subject to release under the Freedom of Information Act. 19 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 26 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 27 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 28 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 29 
public-private partnership enables the creation of practical cybersecurity solutions for specific 30 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 31 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 32 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 33 
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity 34 
solutions using commercially available technology. The NCCoE documents these example solutions in 35 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 36 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 37 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 38 
Maryland. 39 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 40 
https://www.nist.gov. 41 

NIST CYBERSECURITY PRACTICE GUIDES 42 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 43 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 44 
adoption of standards-based approaches to cybersecurity. They show members of the information 45 
security community how to implement example solutions that help them align with relevant standards 46 
and best practices, and provide users with the materials lists, configuration files, and other information 47 
they need to implement a similar approach. 48 

The documents in this series describe example implementations of cybersecurity practices that 49 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 50 
or mandatory practices, nor do they carry statutory authority. 51 

ABSTRACT 52 

Increasingly, healthcare delivery organizations (HDOs) are relying on telehealth and remote patient 53 
monitoring (RPM) capabilities to treat patients at home. RPM is convenient and cost-effective, and its 54 
adoption rate has increased. However, without adequate privacy and cybersecurity measures, 55 
unauthorized individuals may expose sensitive data or disrupt patient monitoring services. 56 

RPM solutions engage multiple actors as participants in a patient’s clinical care. These actors include 57 
HDOs, telehealth platform providers, and the patients themselves. Each participant uses, manages, and 58 
maintains different technology components within an interconnected ecosystem, and each is 59 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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responsible for safeguarding their piece against unique threats and risks associated with RPM 60 
technologies. 61 

This practice guide assumes that the HDO engages with a telehealth platform provider that is a separate 62 
entity from the HDO and patient. The telehealth platform provider manages a distinct infrastructure, 63 
applications, and set of services. The telehealth platform provider coordinates with the HDO to 64 
provision, configure, and deploy the RPM components to the patient home and assures secure 65 
communication between the patient and clinician. 66 

The NCCoE analyzed risk factors regarding an RPM ecosystem by using risk assessment based on the 67 
NIST Risk Management Framework. The NCCoE also leveraged the NIST Cybersecurity Framework, NIST 68 
Privacy Framework, and other relevant standards to identify measures to safeguard the ecosystem. In 69 
collaboration with healthcare, technology, and telehealth partners, the NCCoE built an RPM ecosystem 70 
in a laboratory environment to explore methods to improve the cybersecurity of an RPM.  71 

Technology solutions alone may not be sufficient to maintain privacy and security controls on external 72 
environments. This practice guide notes the application of people, process, and technology as necessary 73 
to implement a holistic risk mitigation strategy.  74 

This practice guide’s capabilities include helping organizations assure the confidentiality, integrity, and 75 
availability of an RPM solution, enhancing patient privacy, and limiting HDO risk when implementing an 76 
RPM solution. 77 

KEYWORDS 78 

access control; authentication; authorization; behavioral analytics; cloud storage; data privacy; data 79 
security; encryption; HDO; healthcare; healthcare delivery organization; remote patient monitoring; 80 
RPM; telehealth 81 
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The Technology Partners/Collaborators who participated in this build submitted their capabilities in 84 
response to a notice in the Federal Register. Respondents with relevant capabilities or product 85 
components were invited to sign a Cooperative Research and Development Agreement (CRADA) with 86 
NIST, allowing them to participate in a consortium to build this example solution. We worked with: 87 

Technology Partner/Collaborator Build Involvement 

Accuhealth Accuhealth Evelyn 

Cisco Cisco Firepower Version 6.3.0 
Cisco Umbrella 
Cisco Stealthwatch Version 7.0.0 

Inova Health System subject matter expertise 

LogRhythm LogRhythm XDR Version 7.4.9 
LogRhythm NetworkXDR Version 4.0.2 

MedCrypt subject matter expertise 

MedSec subject matter expertise 

Onclave Networks, Inc. (Onclave) Onclave Zero Trust Platform Version 1.1.0 

Tenable Tenable.sc Vulnerability Management Version 5.13.0 with 
Nessus 

The University of Mississippi Medical 
Center 

subject matter expertise 

Vivify Health Vivify Pathways Home 
Vivify Pathways Care Team Portal 

88 

DOCUMENT CONVENTIONS 89 

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the 90 
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that 91 
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among several possibilities, one is recommended as particularly suitable without mentioning or 92 
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in 93 
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms 94 
“may” and “need not” indicate a course of action permissible within the limits of the publication. The 95 
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal. 96 

CALL FOR PATENT CLAIMS 97 

This public review includes a call for information on essential patent claims (claims whose use would be 98 
required for compliance with the guidance or requirements in this Information Technology Laboratory 99 
(ITL) draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication 100 
or by reference to another publication. This call also includes disclosure, where known, of the existence 101 
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant 102 
unexpired U.S. or foreign patents. 103 

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in 104 
written or electronic form, either: 105 

a) assurance in the form of a general disclaimer to the effect that such party does not hold and does not106 
currently intend holding any essential patent claim(s); or 107 

b) assurance that a license to such essential patent claim(s) will be made available to applicants desiring108 
to utilize the license for the purpose of complying with the guidance or requirements in this ITL draft 109 
publication either: 110 

1. under reasonable terms and conditions that are demonstrably free of any unfair discrimination;111 
or112 

2. without compensation and under reasonable terms and conditions that are demonstrably free113 
of any unfair discrimination.114 

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its 115 
behalf) will include in any documents transferring ownership of patents subject to the assurance, 116 
provisions sufficient to ensure that the commitments in the assurance are binding on the transferee, 117 
and that the transferee will similarly include appropriate provisions in the event of future transfers with 118 
the goal of binding each successor-in-interest. 119 

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of 120 
whether such provisions are included in the relevant transfer documents. 121 

Such statements should be addressed to: hit_nccoe@nist.gov 122 

mailto:hit_nccoe@nist.gov
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1 Introduction 144 

The following volumes of this guide show information technology (IT) professionals and security 145 
engineers how we implemented this example solution. We cover all of the products employed in this 146 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 147 
to be widely available. Rather, these volumes show how we incorporated the products together in our 148 
environment. 149 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 150 
for these products that are out of scope for this reference design. 151 

1.1 How to Use this Guide 152 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 153 
standards-based reference design and provides users with the information they need to replicate the 154 
telehealth remote patient monitoring (RPM) environment. This reference design is modular and can be 155 
deployed in whole or in part. 156 

This guide contains three volumes: 157 

 NIST SP 1800-30A: Executive Summary158 

 NIST SP 1800-30B: Approach, Architecture, and Security Characteristics–what we built and why159 

 NIST SP 1800-30C: How-To Guides–instructions for building the example solution (you are here)160 

Depending on your role in your organization, you might use this guide in different ways: 161 

Business decision makers, including chief security and technology officers, will be interested in the 162 
Executive Summary, NIST SP 1800-30A, which describes the following topics: 163 

 challenges that enterprises face in securing the remote patient monitoring ecosystem164 

 example solution built at the NCCoE165 

 benefits of adopting the example solution166 

Technology or security program managers who are concerned with how to identify, understand, assess, 167 
and mitigate risk will be interested in NIST SP 1800-30B, which describes what we did and why. The 168 
following sections will be of particular interest: 169 

 Section 3.4, Risk Assessment, describes the risk analysis we performed.170 

 Section 3.5, Security Control Map, maps the security characteristics of this example solution to171 
cybersecurity standards and best practices.172 
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You might share the Executive Summary, NIST SP 1800-30A, with your leadership team members to help 173 
them understand the importance of adopting standards-based commercially available technologies that 174 
can help secure the RPM ecosystem. 175 

IT professionals who want to implement an approach like this will find this whole practice guide useful. 176 
You can use this How-To portion of the guide, NIST SP 1800-30C, to replicate all or parts of the build 177 
created in our lab. This How-To portion of the guide provides specific product installation, configuration, 178 
and integration instructions for implementing the example solution. We do not recreate the product 179 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 180 
incorporated the products together in our environment to create an example solution. 181 

This guide assumes that IT professionals have experience implementing security products within the 182 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 183 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 184 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 185 
parts of the National Cybersecurity Center of Excellences’ (NCCoE’s) risk assessment and deployment of 186 
a defense-in-depth strategy in a distributed RPM solution. Your organization’s security experts should 187 
identify the products that will best integrate with your existing tools and IT system infrastructure. We 188 
hope that you will seek products that are congruent with applicable standards and best practices. 189 
Section 3.6, Technologies, lists the products that we used and maps them to the cybersecurity controls 190 
provided by this reference solution. 191 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 192 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 193 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 194 
hit_nccoe@nist.gov. 195 

Acronyms used in figures are in the List of Acronyms appendix. 196 

1.2 Build Overview 197 

The NCCoE constructed a virtual lab environment to evaluate ways to implement security capabilities 198 
across an RPM ecosystem, which consists of three separate domains: patient home, telehealth platform 199 
provider, and healthcare delivery organization (HDO). The project implements virtual environments for 200 
the HDO and patient home while collaborating with a telehealth platform provider to implement a 201 
cloud-based telehealth RPM environment. The telehealth environments contain simulated patient data 202 
that portray relevant cases that clinicians could encounter in real-world scenarios. The project then 203 
applies security controls to the virtual environments. Refer to NIST Special Publication (SP) 1800-30B, 204 
Section 5, Security Characteristic Analysis, for an explanation of why we used each technology. 205 

mailto:hit_nccoe@nist.gov
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1.3 Typographic Conventions 206 

The following table presents typographic conventions used in this volume. 207 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

1.4 Logical Architecture Summary 208 

Figure 1-1 illustrates the reference network architecture implemented in the NCCoE virtual 209 
environment, initially presented in NIST SP 1800-30B, Section 4.5, Final Architecture. The HDO 210 
environment utilizes network segmenting similar to the architecture segmentation used in NIST SP 1800-211 
24, Securing Picture Archiving and Communication System (PACS) [1]. The telehealth platform provider is 212 
a vendor-managed cloud environment that facilitates data transmissions and communications between 213 
the patient home and the HDO. Patient home environments have a minimalistic structure, which 214 
incorporates the devices provided by the telehealth platform provider. 215 

https://www.nccoe.nist.gov/
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Figure 1-1 Final Architecture 216 

 

2 Product Installation Guides 217 

This section of the practice guide contains detailed instructions for installing and configuring all the 218 
products used to build an instance of the example solution. The project team implemented several 219 
capabilities that included deploying components received from telehealth platform providers and 220 
components that represent the HDO. The telehealth platform providers provisioned biometric devices 221 
that were deployed to a patient home environment. Within the HDO, the engineers deployed network 222 
infrastructure devices to implement network zoning and configure perimeter devices. The engineers 223 
also deployed security capabilities that supported vulnerability management and a security incident and 224 
event management (SIEM) tool. The following sections detail deployment and configuration of these 225 
components.  226 

2.1 Telehealth Platform Provider 227 

The project team implemented a model where an HDO partners with telehealth platform providers to 228 
enable RPM programs. Telehealth platform providers are third parties that, for this practice guide, 229 
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configured, deployed, and managed biometric devices and mobile devices (e.g., tablets) that were sent 230 
to the patient home. The telehealth platform provider managed data communications over cellular and 231 
broadband where patients send biometric data to the telehealth platform provider. The telehealth 232 
platform provider implemented an application that allowed clinicians to access the biometric data. 233 

The team collaborated with two independent telehealth platform providers. Collaborating with two 234 
unique platforms enabled the team to apply NIST’s Cybersecurity Framework [2] to multiple telehealth 235 
platform implementations. One platform provides biomedical devices enabled with cellular data. These 236 
devices transmitted biometric data to the cloud-based telehealth platform. The second platform 237 
provider deployed biometric devices enabled with Bluetooth wireless technology. Biometric devices 238 
communicated with an interface device (i.e., a tablet). The telehealth platform provider configured the 239 
interface device by using a mobile device management solution, limiting the interface device’s 240 
capabilities to those services required for RPM participation. The patient transmitted biometric data to 241 
the telehealth platform provider by using the interface device. The interface device transmitted data 242 
over cellular or broadband data communications. Both telehealth platform providers allowed HDOs to 243 
access patient data by using a web-based application. Both platforms implemented unique access 244 
control policies for access control, authentication, and authorization. Figure 2-1 depicts the different 245 
communication pathways tested in this practice guide. A detailed description of each communications 246 
pathway is provided in NIST SP 1800-30B, Section 4.2, High-Level Architecture Communications 247 
Pathways. 248 
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Figure 2-1 RPM Communications Paths 249 

250 

2.1.1 Accuhealth 251 

Accuhealth provided biometric devices that included cellular data communication. Accuhealth also 252 
included a cloud-hosted application for HDOs to access patient-sent biometric data. Accuhealth 253 
provisioned biomedical devices with subscriber identity module (SIM) cards that enabled biomedical 254 
devices to transmit data via cellular data communications to the Accuhealth telehealth platform. 255 
Accuhealth stored patient-transmitted data in an application. Individuals assigned with clinician roles 256 
accessed transmitted data hosted in the Accuhealth application. The biomedical data displayed in the 257 
following screen captures are notional in nature and do not relate to an actual patient. 258 

2.1.1.1 Patient Home–Communication Path A 259 

This practice guide assumes that the HDO enrolls the patient in an RPM program. Clinicians would 260 
determine when a patient may be enrolled in the program appropriately, and conversations would occur 261 
about understanding the roles and responsibilities associated with participating in the RPM program. 262 
When clinicians enroll patients in the RPM program, the HDO would collaborate with Accuhealth. 263 
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Accuhealth received patient contact information and configured biometric devices appropriate for the 264 
RPM program in which the patient was enrolled. Accuhealth configured biometric devices to 265 
communicate via cellular data, which is depicted as communication path A of Figure 2-1. Biometric 266 
devices, thus, were isolated from the patient home network environment. Accuhealth assured device 267 
configuration and asset management. 268 

2.1.1.2 HDO 269 

The Accuhealth solution includes installing an application within the HDO environment. Clinicians access 270 
a portal hosted by Accuhealth that allows a clinician to view patient biometric data. The application 271 
requires unique user accounts and role-based access control. System administrators create accounts and 272 
assign roles through an administrative console. Sessions from the clinician to the hosted application use 273 
encryption to ensure data-in-transit protection. 274 

This section discusses the HDO application installation and configuration procedures. 275 

1. Access a device that has a web browser.276 

2. Navigate to Accuhealth login page, and provide a Username and Password. The following277 
screenshots show a doctor’s point of view in the platform.278 

3. Click LOG IN.279 

After logging in, the Patient Overview screen displays. 280 
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4. To view patients associated with the account used to log in, navigate to the View Select drop-281 
down list in the top left corner of the screen, and select My Patients.282 

5. Click a Patient to display the Patient Details page, which displays all patient biomedical283 
readings.284 
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6. To leave a comment on a reading, click no comments yet under the Comments column on the 285 
row of the reading to which the comment refers. 286 

7. A Comment screen displays that allows free text input. 287 

8. Click Comment. 288 

9. Click Close. 289 
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10. To have a call with a patient, click Request an Appointment in the top left of the Patient Details 290 
page.  291 

11. A notification box displays, asking if the Home Health Agency needs to schedule an appointment 292 
with the patient.  293 

12. Click OK.  294 

 

2.1.2 Vivify Health 295 

Vivify provided biometric and interface devices (i.e., Vivify provisioned a tablet device) and a cloud-296 
hosted platform. Vivify enabled biometric devices with Bluetooth communication and provisioned 297 
interface devices with SIM cards. Individuals provisioned with patient roles used the interface device to 298 
retrieve data from the biometric devices via Bluetooth. Individuals acting as patients then used the 299 
interface device to transmit data to Vivify by using cellular data. Vivify’s application presented the 300 
received data. Individuals provisioned with clinician roles accessed the patient-sent data stored in the 301 
Vivify application via a web interface. 302 

2.1.2.1 Patient Home–Communication Path B 303 

This practice guide assumes that the HDO enrolls the patient in an RPM program. Clinicians would 304 
determine when a patient may be enrolled in the program appropriately, and conversations then occur 305 
about understanding the roles and responsibilities associated with participating in the RPM program. 306 
When clinicians enroll patients in the RPM program, the HDO would collaborate with Vivify. Vivify 307 
received patient contact information and configured biometric devices and an interface device (i.e., 308 
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tablet) appropriate for the RPM program in which the patient was enrolled. These devices were 309 
configured to transmit data via cellular through the interface device, which is depicted as 310 
communication path B in Figure 2-1. Vivify assured device configuration and asset management. 311 

2.1.2.2 Patient Home–Communication Paths C and D 312 

To evaluate communication path C in Figure 2-1, the project team implemented another instance of the 313 
Vivify Pathways Care Team Portal in a simulated cloud environment. The simulated cloud environment 314 
represented how a telehealth platform provider may operate; however, it does not reflect how any 315 
specific telehealth platform provider hosts its components. The simulated cloud environment deployed 316 
Vivify-provided software, but note that the simulated cloud environment does not represent how Vivify 317 
implements its service offering. The NCCoE implemented the simulated cloud environment as a test case 318 
where telehealth platforms may incorporate layer 2 over layer 3 solutions as part of their architecture. A 319 
Vivify Pathways Home kit was hosted in a patient home network, which included peripherals as well as 320 
an RPM interface. Engineers connected the RPM interface (mobile device) to the patient home network 321 
to enable broadband communications with the new simulated cloud instance. The RPM interface 322 
collected patient data from the provided peripherals via Bluetooth and then transmitted this data to the 323 
simulated cloud environment through the broadband connection.  324 

After implementing communication path C and the Onclave Network Solution, the RPM interface 325 
connected to an add-on security control, Onclave Home Gateway, inside the patient home environment. 326 
Once the RPM interface was connected to the Onclave Home Gateway, patient data were transmitted to 327 
the simulated cloud environment through the Onclave Telehealth Gateway. These connections enabled 328 
the project team to implement communication path D as depicted in Figure 2-1. Details on how 329 
engineers installed and configured Onclave tools are described in section 2.2.4.1, Onclave SecureIoT.  330 

2.1.2.3 Telehealth Platform–Communication Paths C and D 331 

For communication paths C and D, a simulated cloud environment was created to represent a telehealth 332 
platform provider that supports broadband-capable biometric devices. A sample Vivify Pathways Care 333 
Team Portal was obtained to demonstrate how patient data could be transmitted via broadband 334 
communications. Practitioners should note, however, that Vivify as an entity may not support this use 335 
case. Vivify engineers facilitated deploying the Vivify Pathways Care Team Portal as representative of 336 
how a telehealth platform provider may support the communications pathway. Communication paths A 337 
and B used telehealth platform providers that were located outside the NCCoE lab, and data were 338 
transmitted via cellular communications.  339 

Communication path D required more add-on security controls to be configured in the virtual cloud 340 
environment. For this communication pathway, the representative Vivify Pathways Care Team Portal 341 
was connected to an Onclave Telehealth Gateway. This gateway accepted data transmissions from the 342 
RPM interface connected to the Onclave Home Gateway housed in the patient home environment.  343 
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2.1.2.4 HDO 344 

Using a web browser interface, clinicians access a portal hosted by Vivify that allows access to view 345 
patient biometric data. Portal interaction requires unique user accounts and role-based access control. 346 
System administrators create accounts and assign roles through an administrative console. Sessions 347 
from the clinician to the hosted application use encryption to ensure data-in-transit protection.  348 

This section discusses the HDO application installation and configuration procedures. 349 

1. Access a device that has a web browser.  350 

2. Navigate to https://<vivifyhealth site>/CaregiverPortal/Login and give the Username and 351 
Password of the administrative account provided by Vivify. 352 

3. Click Login. 353 

 354 

4. Navigate to the Care Team menu item on the left-hand side of the screen. 355 

Click + New User. 356 

5. In the New User screen, provide the following information: 357 

a. First Name: Test 358 
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b. Last Name: Clinician 359 

c. User Name: TClinician1 360 

d. Password: ********** 361 

e. Confirm Password: ********** 362 

f. Facilities: Vivify General 363 

g. Sites: Default 364 

h. Roles: Clinical Level 1, Clinical Level 2 365 

i. Email Address: ********** 366 

j. Mobile Phone: ********* 367 

6. Click Save Changes. 368 

7. Navigate to Patients in the left-hand menu bar. 369 

8. Select the NCCoE, Patient record.  370 

9. Under Care Team, click the notepad and pencil in the top right of the box.  371 

10. In the Care Team window, select Clinician, Test and click Ok.  372 

11. Log out of the platform. 373 

12. Log in to the platform by using the Test Clinician credentials, and click Login.  374 

13. Click the NCCoE, Patient record.  375 

14. Navigate to the Monitoring tab to review patient readings.  376 

15. Based on the patient’s data, the clinician needs to consult the patient. 377 

16. Click the ellipsis in the NCCoE, Patient menu above the green counter. 378 

17. Select Call Patient.  379 

18. In the Respond to Call Request screen, select Phone Call Now.  380 

19. After the consultation, record the action items performed during the call. 381 

20. In the Monitoring window, click Accept All under the Alerts tab to record intervention steps. 382 

21. In the Select Intervention window, select the steps performed to address any patient alerts. 383 

22. Click Accept.  384 
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23. Navigate to Notes to review recorded interventions or add other clinical notes. 385 

2.2 Security Capabilities 386 

The following instruction and configuration steps depict how the NCCoE engineers along with project 387 
collaborators implemented provided cybersecurity tools to achieve the desired security capabilities 388 
identified in NIST SP 1800-30B, Section 4.4, Security Capabilities.  389 

2.2.1 Risk Assessment Controls 390 

Risk assessment controls align with the NIST Cybersecurity Framework’s ID.RA category. For this practice 391 
guide, the Tenable.sc solution was implemented as a component in an HDO’s risk assessment program. 392 
While Tenable.sc includes a broad functionality set, the project team leveraged Tenable.sc’s 393 
vulnerability scanning and management capabilities. 394 

2.2.1.1 Tenable.sc 395 

Tenable.sc is a vulnerability management solution. Tenable.sc includes vulnerability scanning and 396 
configuration checking, which displays information through a dashboard graphical user interface (GUI). 397 
Tenable.sc’s dashboard includes vulnerability scoring, enabling engineers to prioritize patching and 398 
remediation. The engineers used Tenable.sc to manage a Nessus scanner, which performed vulnerability 399 
scanning against HDO domain-hosted devices. While the Tenable.sc solution includes configuration-400 
checking functionality, this practice guide uses the solution for vulnerability management. 401 

System Requirements 402 

Central Processing Unit (CPU): 4 403 

Memory: 8 gigabytes (GB) 404 

Storage: 250 GB 405 

Operating System: CentOS 7 406 

Network Adapter: virtual local area network (VLAN) 1348 407 

Tenable.sc Installation 408 

This section discusses installation of the Tenable.sc vulnerability management solution.  409 

1. Import the Tenable.sc open virtual appliance or appliance (OVA) file to the virtual environment. 410 

2. Assign the virtual machine (VM) to VLAN 1348. 411 

3. Start the VM, and document the associated internet protocol (IP) address. 412 

4. Open a web browser that can talk to VLAN 1348, and navigate to the VM’s IP address. 413 
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5. For the first login, use wizard as the Username and admin for the Password. 414 

6. Tenable.sc prompts a pop-up window for creating a new admin username and password. 415 

7. Repeat step 5 using the new username and password. 416 

a. Username: admin 417 

b. Password: ********** 418 

c. Check the box beside Reuse my password for privileged tasks. 419 

  

8. After logging in, the Tenable Management Console page displays. 420 

9. Click the Tenable.sc menu option on the left side of the screen. 421 

10. To access Tenable.sc, click the IP address next to the uniform resource locator (URL) field. 422 
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11. Log in to Tenable.sc by using the credentials created in previous steps, and click Sign In. 423 

a. Username: admin 424 

b. Password: ********** 425 
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12. After signing in, Tenable.sc’s web page displays. 426 

13. Navigate to the System drop-down list in the menu ribbon. 427 

14. Click Configuration. 428 

15. Under Tenable.sc License, click Upload next to License File. 429 

16. Navigate to the storage location of the Tenable.sc license key obtained from a Tenable 430 
representative, and select the key file. 431 

17. Click OK. 432 

18. Click Validate. 433 

19. When Tenable.sc accepts the key, a green Valid label will display next to License File. 434 
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20. Under Additional Licenses, input the Nessus license key provided by a Tenable representative 435 
next to Nessus Scanner. 436 

21. Click Register. 437 
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Tenable.sc Configuration 438 

The project team leveraged support from Tenable engineers. Collectively, engineers installed Tenable.sc 439 
and validated license keys for Tenable.sc and Nessus. Engineers created Organization, Repository, User, 440 
Scanner, and Scan Zones instances for the HDO lab environment. The configuration steps are below.  441 

Add an Organization 442 

1. Navigate to Organizations in the menu ribbon. 443 

2. Click +Add in the top right corner of the screen. An Add Organization page will appear. 444 

3. Name the Organization RPM HDO and leave the remaining fields as their default values. 445 

4. Click Submit. 446 
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Add a Repository 447 

1. Navigate to the Repositories drop-down list in the menu ribbon. 448 

2. Click +Add in the top right corner of the screen. An Add Repository screen displays. 449 

3. Under Local, click IPv4. An Add IPv4 Repository page displays. Provide the following 450 
information: 451 

a. Name: HDO Repository 452 

b. IP Ranges: 0.0.0.0/24 453 

c. Organizations: RPM HDO 454 

4. Click Submit. 455 
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Add a User 456 

1. Navigate to the Users drop-down list in the menu ribbon. 457 

2. Select Users. 458 

3. Click +Add in the top right corner. An Add User page displays. Provide the following information: 459 

a. Role: Security Manager 460 

b. Organization: RPM HDO 461 
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c. First Name: Test 462 

d. Last Name: User 463 

e. Username: TestSecManager 464 

f. Password: ********** 465 

g. Confirm Password: ********** 466 

h. Enable User Must Change Password. 467 

i. Time Zone: America/New York 468 

4. Click Submit. 469 
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For the lab deployment of Tenable.sc, the engineers instantiated one Nessus scanner in the Security 470 
Services subnet that has access to every subnet in the HDO environment. 471 

Add a Scanner 472 

1. Navigate to the Resources drop-down list in the menu ribbon. 473 

2. Select Nessus Scanners. 474 

3. Click +Add in the top right corner. An Add Nessus Scanner page displays. Fill in the following 475 
information: 476 

a. Name: HDO Scanner 477 

b. Description: Scans the Workstation, Enterprise, HIS, Remote, and Database VLANs 478 

c. Host: 192.168.45.100 479 

d. Port: 8834 480 

e. Enabled: on 481 

f. Type: Password 482 

g. Username: TestSecManager 483 

h. Password: ********** 484 

4. Click Submit. 485 
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The engineers created a scan zone for each subnet established on the HDO network. The process to 486 
create a scan zone is the same for each subnet aside from the IP address range.  487 

As an example, the steps for creating the Workstation scan zone are as follows: 488 

Add a Scan Zone 489 

1. Navigate to the Resources drop-down list in the menu ribbon. 490 

2. Select Scan Zones. 491 
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3. Click +Add. An Add Scan Zone page will appear. Provide the following information: 492 

a. Name: Workstations 493 

b. Ranges: 192.168.44.0/24 494 

c. Scanners: HDO Scanner 495 

4. Click Submit. 496 

 

Repeat steps in Add a Scan Zone section for each VLAN. 497 

To fulfil the identified NIST Cybersecurity Framework Subcategory requirements, the engineers utilized 498 
Tenable’s host discovery and vulnerability scanning capabilities. The first goal was to identify the hosts 499 
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on each of the HDO VLANs. Once Tenable identifies the assets, Tenable.sc executes a basic network scan 500 
to identify any vulnerabilities on these assets. 501 

Create Scan Policies 502 

1. Engineers created a Security Manager account in a previous step when adding users. Log in to 503 
Tenable.sc by using the Security Manager account.  504 

2. Navigate to the Scans drop-down list in the menu ribbon. 505 

3. Select Policies. 506 

4. Click +Add in the top right corner. 507 

5. Click Host Discovery in the Add Policy page. An Add Policy > Host Discovery page will appear. 508 
Provide the following information: 509 

a. Name: HDO Assets 510 

b. Discovery: Host enumeration 511 

c. Leave the remaining options as their default values. 512 

6. Click Submit. 513 
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7. Click +Add in the top right corner. 514 

8. Click Basic Network Scan in the Add Policy page. An Add Policy > Basic Network Scan page 515 
displays. 516 

9. Name the scan HDO Network Scan and leave the remaining options to their default settings. 517 

10. Click Submit. 518 

 

Create Active Scans 519 

1. Navigate to the Scans drop-down list in the menu ribbon. 520 

2. Select Active Scans. 521 

3. Click +Add in the top right corner. An Add Active Scan page will appear. Provide the following 522 
information for General and Target Type sections. 523 

General 524 

a. Name: Asset Scan 525 

b. Description: Identify hosts on the VLANs 526 

c. Policy: Host Discovery 527 

Targets 528 

a. Target Type: IP/DNS Name 529 
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b. IPs/DNS Names: 192.168.44.0/24, 192.168.40.0/24, 192.168.41.0/24,    530 
      192.168.42.0/24, 192.168.43.0/24 531 

4. Click Submit. 532 
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Repeat steps in Create Active Scans section for the Basic Network Scan policy. Keep the same value as 533 
defined for Active Scan except the following: 534 

a. Name the scan HDO Network Scan. 535 

b. Set Policy to HDO Network Scan. 536 

After the engineers created and correlated the Policies and Active Scans to each other, they executed 537 
the scans. 538 

Execute Active Scans 539 

1. Navigate to the Scans drop-down list in the menu ribbon. 540 

2. Select Active Scans. 541 

3. Next to HDO Asset Scan click . 542 

4. Navigate to the Scan Results menu option shown at the top of the screen under the menu 543 
ribbon to see the status of the scan. 544 

5. Click HDO Asset Scan to see the scan results. 545 

6. Repeat the above steps for HDO Network Scan. 546 

View Active Scan Results in the Dashboard 547 

1. Navigate to the Dashboard drop-down list in the menu ribbon. 548 

2. Select Dashboard. 549 



SECOND DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 30 

3. In the top right, click Switch Dashboard. 550 

4. Click Vulnerability Overview. A screen will appear that displays a graphical representation of the 551 
vulnerability results gathered during the HDO Host Scan and HDO Network Scan. 552 

2.2.1.2 Nessus 553 

Nessus is a vulnerability scanning engine that evaluates a host’s operating system and configuration to 554 
determine the presence of exploitable vulnerabilities. This project uses one Nessus scanner to scan each 555 
VLAN created in the HDO environment to identify hosts on each VLAN and the vulnerabilities associated 556 
with those hosts. Nessus sends the results back to Tenable.sc, which graphically represents the results in 557 
dashboards. 558 

System Requirements 559 

CPU: 4 560 

Memory: 8 GB 561 

Storage: 82 GB 562 

Operating System: CentOS 7 563 

Network Adapter: VLAN 1348 564 

Nessus Installation 565 

1. Import the OVA file to the virtual lab environment. 566 

2. Assign the VM to VLAN 1348. 567 

3. Start the VM, and document the associated IP address. 568 

4. Open a web browser that can talk to VLAN 1348, and navigate to the VM’s IP address. 569 

5. Log in using wizard as the Username and admin for the Password. 570 

6. Create a new admin username and password. 571 

7. Log in using the new username and password. 572 

a. Username: admin 573 

b. Password: ********** 574 

c. Enable Reuse my password for privileged tasks. 575 
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8. Click Tenable.sc on the left side of the screen. 576 

9. To access Tenable.sc, click the IP address next to the URL field. 577 
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Nessus Configuration 578 

The engineers utilized Tenable.sc to manage Nessus. To configure Nessus as managed by Tenable.sc, 579 
follow Tenable’s Managed by Tenable.sc guide [3]. 580 

2.2.2 Identity Management, Authentication, and Access Control 581 

Identity management, authentication, and access control align with the NIST Cybersecurity Framework 582 
PR.AC control. The engineers implemented capabilities in the HDO to address this control category. First, 583 
they implemented Microsoft Active Directory (AD), then installed a domain controller to establish an 584 
HDO domain. Next, the engineers implemented Cisco Firepower as part of its network core 585 
infrastructure. They used Cisco Firepower to build VLANs that aligned to network zones. Cisco Firepower 586 
also was configured to provide other network services. Details on installation are included in the 587 
following sections. 588 

2.2.2.1 Domain Controller 589 

The engineers installed a Windows Server domain controller within the HDO to manage AD and local 590 
domain name service (DNS) for the enterprise. The following section details how the engineers installed 591 
the services. 592 

Domain Controller Appliance Information 593 
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CPU: 4 594 

Random Access Memory (RAM): 8 GB 595 

Storage: 120 GB (Thin Provision) 596 

Network Adapter 1: VLAN 1327 597 

Operating System: Microsoft Windows Server 2019 Datacenter 598 

Domain Controller Appliance Installation Guide 599 

Install the appliance according to the instructions detailed in Microsoft’s Install Active Directory Domain 600 
Services (Level 100) documentation [4]. 601 

Verify Domain Controller Installation 602 

1. Launch Server Manager. 603 

2. Click Tools > Active Directory Domains and Trusts. 604 

 

3. Right-click hdo.trpm. 605 

4. Click Manage. 606 
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 607 

5. Click hdo.trpm > Domain Controllers. 608 

6. Check that the Domain Controllers directory lists the new domain controller. 609 

 610 

Configure Local DNS 611 

1. Launch Server Manager. 612 

2. Click Tools > DNS. 613 
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3. Click the arrow symbol for DC-HDO. 614 

4. Right-click Reverse Lookup Zones. 615 

5. Click New Zone…. The New Zone Wizard displays. 616 

 

6. Click Next >.  617 
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7. Click Primary zone. 618 

8. Check Store the zone in Active Directory. 619 

9. Click Next >. 620 
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10. Check To all DNS servers running on domain controllers in this forest: hdo.trpm. 621 

11. Click Next >. 622 
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12. Check IPv4 Reverse Lookup Zone. 623 

13. Click Next >. 624 
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14. Check Network ID. 625 

15. Under Network ID, type 192.168. 626 

16. Click Next >. 627 
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17. Check Allow only secure dynamic updates. 628 

18. Click Next >. 629 
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19. Click Finish. 630 
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20. Click the arrow symbol for Reverse Lookup Zones. 631 

21. Right-click 168.192.in-addr.arpa. 632 

22. Click New Pointer (PTR)…. 633 
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23. Under Host name, click Browse…. 634 
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24. Under Look in, select hdo.trpm. 635 

25. Under Records, select dc-hdo. 636 

26. Click OK. 637 
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27. Click OK. 638 
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2.2.2.2 Cisco Firepower 639 

Cisco Firepower consists of two primary components: Cisco Firepower Management Center and Cisco 640 
Firepower Threat Defense (FTD). Cisco Firepower provides firewall, intrusion prevention, and other 641 
networking services. This project used Cisco Firepower to implement VLAN network segmentation, 642 
network traffic filtering, internal and external routing, applying an access control policy, and Dynamic 643 
Host Configuration Protocol (DHCP). Engineers deployed Cisco Firepower as a core component for the 644 
lab’s network infrastructure. 645 

Cisco Firepower Management Center (FMC) Appliance Information 646 

CPU: 4 647 

RAM: 8 GB 648 

Storage: 250 GB (Thick Provision) 649 

Network Adapter 1: VLAN 1327 650 

Operating System: Cisco Fire Linux 6.4.0 651 

Cisco Firepower Management Center Installation Guide 652 

Install the appliance according to the instructions detailed in the Cisco Firepower Management Center 653 
Virtual Getting Started Guide [5]. 654 

Cisco FTD Appliance Information 655 

CPU: 8 656 
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RAM: 16 GB 657 

Storage: 48.5 GB (Thick Provision) 658 

Network Adapter 1: VLAN 1327 659 

Network Adapter 2: VLAN 1327 660 

Network Adapter 3: VLAN 1316 661 

Network Adapter 4: VLAN 1327 662 

Network Adapter 5: VLAN 1328 663 

Network Adapter 6: VLAN 1329 664 

Network Adapter 7: VLAN 1330 665 

Network Adapter 8: VLAN 1347 666 

Network Adapter 9: VLAN 1348 667 

Operating System: Cisco Fire Linux 6.4.0 668 

Cisco FTD Installation Guide 669 

Install the appliance according to the instructions detailed in the Cisco Firepower Threat Defense Virtual 670 
for VMware Getting Started Guide in the Deploy the Firepower Threat Defense Virtual chapter [6]. 671 

Configure FMC Management of FTD 672 

The Cisco Firepower Threat Defense Virtual for VMware Getting Started Guide’s Managing the Firepower 673 
Threat Defense Virtual with the Firepower Management Center (FMC) chapter covers how we registered 674 
the FTD appliance with the FMC [7]. 675 

Once the FTD successfully registers with the FMC, it will appear under Devices > Device Management in 676 
the FMC interface. 677 
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From the Device Management section, the default routes, interfaces, and DHCP settings can be 678 
configured. To view general information for the FTD appliance, navigate to Devices > Device 679 
Management > FTD-TRPM > Device. 680 
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Configure Cisco FTD Interfaces for the RPM Architecture 681 

By default, each of the interfaces is defined as GigabitEthernet and is denoted as 0 through 6.  682 
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1. From Devices > Device Management > FTD-TRPM > Device, click Interfaces.  683 

2. On the Cisco FTD Interfaces window, an Edit icon appears on the far right. The first 684 
GigabitEthernet interface configured is GigabitEthernet0/0. Click the Edit icon to configure the 685 
GigabitEthernet interface.  686 

 

3. The Edit Physical Interface group box displays. Under the General tab, enter WAN in the Name 687 
field. 688 
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4. Under Security Zone, click the drop-down arrow and select New…. 689 
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5. The New Security Zone pop-up box appears. Enter WAN in the Enter a name… field.  690 

6. Click OK. 691 
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7. On the Edit Physical Interface page group box, click the IPv4 tab. 692 
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8. Fill out the following information: 693 

a. IP Type: Use Static IP 694 

b. IP Address: 192.168.4.50/24 695 

c. Click OK. 696 
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9. Configure each of the other GigabitEthernet interfaces following the same pattern described 697 
above, populating the respective IP addresses that correspond to the appropriate VLAN. Values 698 
for each VLAN are described below: 699 

a. GigabitEthernet0/0 (VLAN 1316) 700 

i. Name: WAN 701 

ii. Security Zone: WAN 702 

iii. IP Address: 192.168.4.50/24 703 

b. GigabitEthernet0/1 (VLAN 1327) 704 

i. Name: Enterprise-Services 705 

ii. Security Zone: Enterprise-Services 706 

iii. IP Address: 192.168.40.1/24 707 

c. GigabitEthernet0/2 (VLAN 1328) 708 

i. Name: HIS-Services 709 
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ii. Security Zone: HIS-Services 710 

iii. IP Address: 192.168.41.1/24 711 

d. GigabitEthernet0/3 (VLAN 1329) 712 

i. Name: Remote-Services 713 

ii. Security Zone: Remote-Services 714 

iii. IP Address: 192.168.42.1/24 715 

e. GigabitEthernet0/4 (VLAN 1330) 716 

i. Name: Databases 717 

ii. Security Zone: Databases 718 

iii. IP Address: 192.168.43.1/24 719 

f. GigabitEthernet0/5 (VLAN 1347) 720 

i. Name: Clinical-Workstations 721 

ii. Security Zone: Clinical-Workstations 722 

iii. IP Address: 192.168.44.1/24 723 

g. GigabitEthernet0/6 (VLAN 1348) 724 

i. Name: Security-Services 725 

ii. Security Zone: Security-Services 726 

iii. IP Address: 192.168.45.1/24 727 

10. Click Save. 728 

11. Click Deploy. Verify that the interfaces have been configured properly. Selecting the Devices tab, 729 
the Device Management screen displays the individual interfaces, assigned logical names, type 730 
of interface, security zone labeling, and assigned IP address network that corresponds to the 731 
VLANs that are assigned per security zone. 732 
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Configure Cisco FTD DHCP 733 

1. From Devices > Device Management > FTD-TRPM > Interfaces, click DHCP. 734 

2. Click the plus symbol next to Primary DNS Server. 735 

 

3. The New Network Object pop-up window appears. Fill out the following information: 736 

a. Name: Umbrella-DNS-1 737 

b. Network (Host): 192.168.40.30 738 
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4. Click Save. 739 

 

5. Click the plus symbol next to Secondary DNS Server. 740 

6. The New Network Object pop-up window appears. Fill out the following information: 741 

a. Name: Umbrella-DNS-2 742 

b. Network (Host): 192.168.40.31 743 

7. Under Domain Name, add hdo.trpm. 744 

8. Click Add Server. 745 

 

9. The Add Server pop-up window appears. Fill out the following information: 746 

a. Interface: Enterprise-Services 747 
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b. Address Pool: 192.168.40.100-192.168.40.254 748 

c. Enable DHCP Server: checked 749 

10. Click OK. 750 

 

11. Add additional servers by following the same pattern described above, populating the 751 
respective Interface and Address Pool, and check the Enable DHCP Server that corresponds to 752 
the appropriate server. Values for each server are described below: 753 

a. Interface: Enterprise-Services 754 

i. Address Pool: 192.168.40.100-192.168.40.254 755 

ii. Enable DHCP Server: checked 756 

b. Interface: HIS-Services 757 

i. Address Pool: 192.168.41.100-192.168.41.254 758 

ii. Enable DHCP Server: checked 759 

c. Interface: Remote-Services 760 

i. Address Pool: 192.168.42.100-192.168.42.254 761 

ii. Enable DHCP Server: checked 762 

d. Interface: Databases 763 

i. Address Pool: 192.168.43.100-192.168.43.254 764 

ii. Enable DHCP Server: checked 765 

e. Interface: Clinical-Workstations 766 



SECOND DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 61 

i. Address Pool: 192.168.44.100-192.168.44.254 767 

ii. Enable DHCP Server: checked 768 

f. Interface: Security-Services 769 

i. Address Pool: 192.168.45.100-192.168.45.254 770 

ii. Enable DHCP Server: checked 771 

12. Click Save. 772 

13. Click Deploy. Verify that the DHCP servers have been configured properly. Select the Devices 773 
tab, and review the DHCP server configuration settings. Values for Ping Timeout and Lease 774 
Length correspond to default values that were not altered. The Domain Name is set to 775 
hdo.trpm, with values that were set for the primary and secondary DNS servers. Below the DNS 776 
server settings, a Server tab displays the DHCP address pool that corresponds to each security 777 
zone. Under the Interface heading, view each security zone label that aligns to the assigned 778 
Address Pool, and review that the Enable DHCP Server setting appears as a green check mark. 779 
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Configure Cisco FTD Static Route 780 

1. From Devices > Device Management > FTD-TRPM > DHCP, click Routing. 781 

2. Click Static Route. 782 
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3. Click Add Route. 783 

 

4. The Add Static Route Configuration pop-up window appears. Fill out the following information: 784 

a. Interface: WAN 785 

b. Selected Network: any-ipv4 786 
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5. Click the plus symbol next to Gateway. 787 

 

6. The New Network Object pop-up window appears. Fill out the following information: 788 

a. Name: HDO-Upstream-Gateway 789 

b. Network (Host): 192.168.4.1 790 

7. Click Save. 791 
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8. Click OK. 792 
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9. Click Save. 793 

10. Click Deploy. Verify that the static route has been set correctly. From Devices, when selecting 794 
the Routing tab, the Static Route will indicate the network routing settings. The screen displays 795 
the static route settings in a table format that includes values for Network, Interface, Gateway, 796 
Tunneled, and Metric. The static route applies to the IP addressing that has been specified, 797 
where network traffic traverses the interface. Note the Gateway value. The Tunneled and 798 
Metric values display the default value. 799 
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Configure Cisco FTD Network Address Translation (NAT) 800 

1. Click Devices > NAT. 801 

2. Click New Policy > Threat Defense NAT. 802 

 

3. The New Policy pop-up window appears. Fill out the following information: 803 

a. Name: TRPM NAT 804 

b. Selected Devices: FTD-TRPM 805 

4. Click Save. 806 
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5. Click the edit symbol for TRPM NAT. 807 

 

6. Click Add Rule. 808 
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7. The Edit NAT Rule pop-up window appears. Under Interface Objects, fill out the following 809 
information: 810 

a. NAT Rule: Auto NAT Rule 811 

b. Type: Dynamic 812 

c. Source Interface Objects: Enterprise-Services 813 

d. Destination Interface Objects: WAN 814 

8. Click Translation. 815 

 

9. Under Translation, fill out the following information: 816 

a. Original Source: Enterprise-Services 817 

b. Translated Source: Destination Interface IP 818 

10. Click OK. 819 
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11. Create additional rules following the same pattern described above, populating the respective 820 
information for each rule. Values for each rule are described below: 821 

a. HIS-Services 822 

i. NAT Rule: Auto NAT Rule 823 

ii. Type: Dynamic 824 

iii. Source Interface Objects: HIS-Services 825 

iv. Destination Interface Objects: WAN 826 

v. Original Source: HIS-Services 827 

vi. Translated Source: Destination Interface IP 828 

b. Remote-Services 829 

i. NAT Rule: Auto NAT Rule 830 

ii. Type: Dynamic 831 

iii. Source Interface Objects: Remote-Services 832 

iv. Destination Interface Objects: WAN 833 

v. Original Source: Remote-Services 834 

vi. Translated Source: Destination Interface IP 835 
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c. Databases 836 

i. NAT Rule: Auto NAT Rule 837 

ii. Type: Dynamic 838 

iii. Source Interface Objects: Databases 839 

iv. Destination Interface Objects: WAN 840 

v. Original Source: Databases 841 

vi. Translated Source: Destination Interface IP 842 

d. Clinical-Workstations 843 

i. NAT Rule: Auto NAT Rule 844 

ii. Type: Dynamic 845 

iii. Source Interface Objects: Clinical-Workstations 846 

iv. Destination Interface Objects: WAN 847 

v. Original Source: Clinical-Workstations 848 

vi. Translated Source: Destination Interface IP 849 

e. Security-Services 850 

i. NAT Rule: Auto NAT Rule 851 

ii. Type: Dynamic 852 

iii. Source Interface Objects: Security-Services 853 

iv. Destination Interface Objects: WAN 854 

v. Original Source: Security-Services 855 

vi. Translated Source: Destination Interface IP 856 

12. Click Save. 857 

13. Click Deploy. Verify the NAT settings through the Devices screen. The NAT rules are displayed in 858 
a table format. The table includes values for Direction of the NAT displayed as a directional 859 
arrow, the NAT Type, the Source Interface Objects (i.e., the security zone IP networks), the 860 
Destination Interface Objects, the Original Sources (i.e., these addresses correspond to the IP 861 
network from where the network traffic originates), the Translated Sources, and Options. The 862 
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settings indicate that IP addresses from the configured security zones are translated behind the 863 
Interface IP address. 864 

 

Configure Cisco FTD Access Control Policy 865 

1. Click Polices > Access Control > Access Control. 866 

2. Click the edit symbol for Default-TRPM. 867 

 

3. Click Add Category. 868 
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4. Fill out the following information: 869 

a. Name: Security Services 870 

b. Insert: into Mandatory 871 

5. Click OK. 872 

 

6. Repeat the previous steps of Add Category section for each network segment in the 873 
architecture. 874 

7. Click Add Rule. 875 

 

8. When the Add Rule screen appears, fill out the following information: 876 

a. Name: Nessus-Tenable 877 

b. Action: Allow 878 

c. Insert: into Category, Security Services 879 

d. Under Networks, click the plus symbol next to Available Networks, and select Add 880 
Object. 881 
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9. When the New Network Object pop-up window appears, fill out the following information: 882 

a. Name: Tenable.sc 883 

b. Network (Host): 192.168.45.101 884 

10. Click Save. 885 

 

11. In the Add Rule screen, under the Networks tab, set Destination Networks to Tenable.sc. 886 

12. Click Ports. 887 
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13. In the Add Rule screen, under the Ports tab, set Selected Destination Ports to 8834. 888 

14. Click Add. 889 

 

15. Repeat the previous steps for any network requirement rules if necessary. 890 

16. Click Save. 891 

17. Click Deploy. 892 

2.2.3 Security Continuous Monitoring 893 

The project team implemented a set of tools that included Cisco Stealthwatch, Cisco Umbrella, and 894 
LogRhythm to address security continuous monitoring. This practice guide uses Cisco Stealthwatch for 895 
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NetFlow analysis. Cisco Umbrella is a service used for DNS-layer monitoring. The LogRhythm tools 896 
aggregate log file information from across the HDO infrastructure and allow behavioral analytics.  897 

2.2.3.1 Cisco Stealthwatch 898 

Cisco Stealthwatch provides network visibility and analysis through network telemetry. This project 899 
integrates Cisco Stealthwatch with Cisco Firepower, sending NetFlow directly from the Cisco FTD 900 
appliance to a Stealthwatch Flow Collector (SFC) for analysis. 901 

Cisco Stealthwatch Management Center (SMC) Appliance Information 902 

CPU: 4 903 

RAM: 16 GB 904 

Storage: 200 GB (Thick Provision) 905 

Network Adapter 1: VLAN 1348 906 

Operating System: Linux 907 

Cisco SMC Appliance Installation Guide 908 

Install the appliance according to the instructions detailed in the Cisco Stealthwatch Installation and 909 
Configuration Guide 7.1 [8]. 910 

Cisco SFC Appliance Information 911 

CPU: 4 912 

RAM: 16 GB 913 

Storage: 300 GB (Thick Provision) 914 

Network Adapter 1: VLAN 1348 915 

Operating System: Linux 916 

Cisco SFC Appliance Installation Guide 917 

Install the appliance according to the instructions detailed in the Cisco Stealthwatch Installation and 918 
Configuration Guide 7.1 [8]. 919 

Accept the default port value 2055 for NetFlow.  920 

Configure Cisco FTD NetFlow for Cisco SFC 921 

1. Click Objects > Object Management > FlexConfig > Text Object. 922 
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2. In the search box, type netflow. 923 

3. Click the edit symbol for netflow_Destination. 924 

 

4. When the Edit Text Object pop-up window appears, fill out the following information: 925 

a. Count: 3 926 

b. 1: Security Services 927 

c. 2: 192.168.45.31 928 

d. 3: 2055 929 

e. Allow Overrides: checked 930 

5. Click Save. 931 
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6. Click the edit symbol for netflow_Event_Types. 932 
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7. When the Edit Text Object pop-up window appears, fill out the following information: 933 

a. Count: 1 934 

b. 1: All 935 

c. Allow Overrides: checked 936 

8. Click Save. 937 
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9. Click Devices > FlexConfig. 938 

10. Click New Policy. 939 

 

11. When the New Policy screen appears, fill out the following information: 940 

a. Name: FTD-FlexConfig 941 

b. Selected Devices: FTD-TRPM 942 

12. Click Save. 943 
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13. Click the edit symbol for FTD-FlexConfig. 944 

 

14. Under the Devices tab, select Netflow_Add_Destination and Netflow_Set_Parameters. 945 

15. Click the right-arrow symbol to move the selections to the Selected Append FlexConfigs 946 
section. 947 
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16. Click Save. 948 

17. Click Deploy. From the Devices screen, verify the FlexConfig settings. Select the FlexConfig tab. 949 
The NetFlow configurations appear in the lower right of the screen as a table. Under Selected 950 
Append FlexConfigs, the table includes columns labeled # which corresponds to the number of 951 
configurations that have been made: Name and Description. 952 
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Create a Custom Policy Management Rule 953 

1. Click Configure > Policy Management. 954 

 

2. Click Create New Policy > Role Policy. 955 
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3. Give the policy a name and description. 956 
4. Under Host Groups, click the plus symbol. 957 

 

5. Under Outside Hosts, select Eastern Asia and Eastern Europe. 958 
6. Click Apply. 959 
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7. Under Core Events, click Select Events. 960 
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8. Select Recon. 961 
9. Click Apply. 962 
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10. Under Core Events > Recon > When Host is Source, select On + Alarm. 963 
11. Click the expand arrow next to Recon. 964 

 

12. Select Behavioral and Threshold. 965 
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13. Click Save. 966 
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2.2.3.2 Cisco Umbrella 967 

Cisco Umbrella is a cloud service that provides protection through DNS-layer security. Engineers 968 
deployed two Umbrella virtual appliances in the HDO to provide DNS routing and protection from 969 
malicious web services. 970 

Cisco Umbrella Forwarder Appliance Information 971 

CPU: 1 972 

RAM: 0.5 GB 973 

Storage: 6.5 GB (Thick Provision) 974 

Network Adapter 1: VLAN 1327 975 

Operating System: Linux 976 

Cisco Umbrella Forwarder Appliance Installation Guide 977 

Install the appliance according to the instructions detailed in Cisco’s Deploy VAs in VMware guidance [9]. 978 

Create an Umbrella Site 979 

1. Click Deployments > Configuration > Sites and Active Directory. 980 

2. Click Settings. 981 

 

3. Click Add New Site. 982 
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4. In the Add New Site pop-up window, set Name to HDO. 983 

5. Click Save. 984 

 

6. Click Deployments > Configuration > Sites and Active Directory. 985 

7. Click the edit symbol for the Site of forwarder-1. 986 

8. Under Site, select HDO. 987 

9. Click Save. 988 
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10. Repeat the previous steps for forwarder-2. 989 

 

Configure an Umbrella Policy 990 

1. Click Policies > Management > All Policies. 991 

2. Click Add. 992 

 

3. Expand the Sites identity. 993 
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4. Select HDO. 994 

5. Click Next. 995 
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6. Click Next. 996 
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7. Click Next. 997 

 

8. Select Moderate. 998 

9. Click Next. 999 
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10. Under Application Settings, use the drop-down menu to select Create New Setting. 1000 

 

11. Under the Control Applications screen, fill out the following information: 1001 
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a. Name: HDO Application Control 1002 

b. Applications to Control: Cloud Storage 1003 

12. Click Save. 1004 

 

13. Click Next. 1005 
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14. Click Next. 1006 
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15. Click Next. 1007 

 

16. Click Next. 1008 
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17. In the Policy Summary screen, set the Name to HDO Site Policy.  1009 

18. Click Save. 1010 
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Configure Windows Domain Controller as the Local DNS Provider 1011 

1. Click Deployments > Configuration > Domain Management. 1012 

2. Click Add. 1013 
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3. In the Add New Bypass Domain or Server popup window, fill out the following information: 1014 

a. Domain: hdo.trpm 1015 

b. Applies To: All Sites, All Devices 1016 

4. Click Save. Verify that the rule for the hdo.trpm has been added. 1017 
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2.2.3.3 LogRhythm XDR (Extended Detection and Response) 1018 

LogRhythm XDR is a SIEM system that receives log and machine data from multiple end points and 1019 
evaluates the data to determine when cybersecurity events occur. The project utilizes LogRhythm XDR in 1020 
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the HDO environment to enable a continuous view of business operations and detect cyber threats on 1021 
assets. 1022 

System Requirements 1023 

CPU: 20 virtual central processing units (vCPUs) 1024 

Memory: 96 GB RAM 1025 

Storage: 1026 

 hard drive C: 220 GB 1027 
 hard drive D: 1 terabyte (TB) 1028 
 hard drive L: 150 GB 1029 

Operating System: Microsoft Windows Server 2016 X64 Standard Edition 1030 

Network Adapter: VLAN 1348 1031 

LogRhythm XDR Installation 1032 

This section describes LogRhythm installation processes.  1033 

Download Installation Packages 1034 

1. Acquire the installation packages from LogRhythm, Inc.  1035 

2. Prepare a virtual Windows Server per the system requirements.  1036 

3. Create three new drives.  1037 

4. Create a new folder from C:\ on the Platform Manager server, and name the folder LogRhythm.  1038 

5. Extract the provided Database Installer tool and LogRhythm XDR Wizard from the installation 1039 
package in C:\LogRhythm. 1040 

Install Database 1041 

1. Open LogRhythmDatabaseInstallTool folder. 1042 

2. Double-click LogRhythmDatabaseInstallTool application file. 1043 

3. Click Run. 1044 

4. A LogRhythm Database Setup window will appear. Set the Which setup is this for? to PM and 1045 
use the default values for Disk Usage. 1046 
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5. The remaining fields will automatically populate with the appropriate values. Click Install. 1047 

6. Click Done to close the LogRhythm Database Setup window. 1048 

Install LogRhythm XDR 1049 

1. Navigate to C:\ and open LogRhythm XDR Wizard folder. 1050 

2. Double-click the LogRhythmInstallerWizard application file. 1051 

3. The LogRhythm Install Wizard 7.4.8 window will appear. 1052 

4. Click Next. 1053 

5. A LogRhythm Install Wizard Confirmation window will appear. 1054 

6. Click Yes to continue. 1055 

7. Check the box beside I accept the terms in the license agreement to accept the License 1056 
Agreement. 1057 

8. Click Next. 1058 

9. In the Selected Applications window, select the following attributes: 1059 

a. Configuration: Select the XM radio button. 1060 
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b. Optional Applications: Check both AI Engine and Web Console boxes. 1061 

10. Click Install. 1062 

 

11. A LogRhythm Deployment Tool window displays. 1063 

12. Click Configure New Deployment. 1064 
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13. In the Deployment Properties window, keep the default configurations and click Ok. 1065 
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14. Click +Add Host IP in the bottom right corner of the screen, and provide the following 1066 
information:  1067 

a. IP Address: 192.168.45.20 1068 

b. Nickname: XM 1069 

15. Click Save. 1070 
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16. Click Create Deployment Package in the bottom right corner of the screen. 1071 

17. A Create Deployment Package window displays.  1072 

18. Click Create Deployment Package. 1073 

 

19. A Select Folder window appears. 1074 

20. Navigate to C:\LogRhythm. 1075 

21. Click Select Folder. 1076 
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22. Click Next Step. 1077 

 

23. Click Run Host Installer on this Host. 1078 
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24. After the Host Installer has finished, click Verify Status. 1079 

 

25. Click Exit to Install Wizard. 1080 
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26. A notification window displays stating the installation could take as long as 30 minutes. Click OK.  1081 
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27. After the Install Wizard has successfully installed the services, click Exit. 1082 
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LogRhythm XDR Configuration 1083 

The LogRhythm XDR configuration includes multiple related components: 1084 

 System Monitor 1085 

 LogRhythm Artificial Intelligence (AI) Engine 1086 

 Mediator Server 1087 

 Job Manager 1088 

 LogRhythm Console 1089 

Configure System Monitor 1090 

1. Open File Explorer, and navigate to C:\Program Files\LogRhythm. 1091 

2. Navigate to LogRhythm System Monitor. 1092 

3. Double-click the lrconfig application file. 1093 

4. In the LogRhythm System Monitor Local Configuration Manager window, provide the following 1094 
information, and leave the remaining fields as their default values: 1095 

a. Data Processor Address: 192.168.45.20 1096 

b. System Monitor IP Address/Index: 192.168.45.20  1097 

5. Click Apply, and then click OK. 1098 



SECOND DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 114 

 

Configure LogRhythm AI Engine 1099 

1. Open File Explorer, and navigate to C:\Program Files\LogRhythm. 1100 

2. Navigate to LogRhythm AI Engine. 1101 

3. Double-click the lrconfig application file. 1102 

4. In the LogRhythm AI Engine Local Configuration Manager window, provide the following 1103 
information, and leave the remaining fields as their default values: 1104 

a. Server: 192.168.45.20 1105 

b. Password: ********** 1106 

5. Click Test Connection, then follow the instruction of the alert window to complete the test 1107 
connection. 1108 

6. Click Apply, and then click OK. 1109 
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Configure Mediator Server 1110 

1. Open File Explorer, and navigate to C:\Program Files\LogRhythm. 1111 

2. Navigate to Mediator Server. 1112 

3. Double-click lrconfig application file. 1113 

4. In the LogRhythm Data Processor Local Configuration Manager window, provide the following 1114 
information, and leave the remaining fields as their default values: 1115 

a. Server: 192.168.45.20 1116 

b. Password: ********** 1117 

 1118 
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5. Click Test Connection, then follow the instruction of the alert window to complete the test 1119 
connection. 1120 

6. Click Apply, and then click OK. 1121 

 

Configure Job Manager 1122 



SECOND DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 117 

1. Open File Explorer and navigate to C:\Program Files\LogRhythm. 1123 

2. Navigate to Job Manager. 1124 

3. Double-click the lrconfig application file. 1125 

4. In the LogRhythm Platform Manager Local Configuration Manager window, provide the 1126 
following information, and leave the remaining fields as their default values: 1127 

a. Server: 192.168.45.20 1128 

b. Password: ********** 1129 

5. Click Test Connection, then follow the instruction of the alert window to complete the test 1130 
connection. 1131 

6. Click Apply, and then click OK. 1132 
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7. Navigate to the Alarming and Response Manager tab in the bottom menu ribbon. 1133 

8. In the Alarming and Response Manager window, provide the following information, and leave 1134 
the remaining fields as their default values: 1135 

a. Server: 192.168.45.20 1136 
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b. Password: ********** 1137 

9. Click Test Connection, then follow the instruction of the alert window to complete the test 1138 
connection. 1139 

10. Click Apply, and then click OK. 1140 
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Configure LogRhythm Console 1141 

1. Open File Explorer and navigate to C:\Program Files\LogRhythm. 1142 

2. Navigate to LogRhythm Console. 1143 
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3. Double-click lrconfig application file. 1144 

4. In the LogRhythm Login window, provide the following information: 1145 

a. EMDB Server: 192.168.45.20 1146 

b. UserID: LogRhythmAdmin 1147 

c. Password: ******** 1148 

5. Click OK. 1149 

 

6. A New Platform Manager Deployment Wizard window displays. Provide the following 1150 
information: 1151 

a. Windows host name for Platform Manager: LogRhythm-XDR 1152 

b. IP Address for Platform Manager: 192.168.45.20 1153 

c. Check the box next to The Platform Manager is also a Data Processor (e.g., an XM 1154 
appliance). 1155 



SECOND DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 122 

d. Check the box next to The Platform Manager is also an AI Engine Server. 1156 

7. Click the ellipsis button next to <Path to LogRhythm License File>, and navigate to the location 1157 
of the LogRhythm License File. 1158 

 

8. The New Knowledge Base Deployment Wizard window displays and shows the import progress 1159 
status. Once LogRhythm has successfully imported the file, a message window will appear 1160 
stating more configurations need to be made for optimum performance. Click OK to open the 1161 
Platform Manager Properties window. 1162 

9. In the Platform Manager Properties window, provide the following information: 1163 

a. Email address: no_reply@logrhythm.com 1164 

b. Address: 192.168.45.20 1165 

10. Click the button next to Platform, enable the Custom Platform radio button, and complete the 1166 
process by clicking Apply, followed by clicking OK. 1167 

mailto:no_reply@logrhythm.com
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11. After the Platform Manager Properties window closes, a message window displays for 1168 
configuring the Data Processor. Click OK to open the Data Processor Properties window. 1169 

12. Click the button next to Platform, and enable the Custom Platform radio button. 1170 

13. Click OK.  1171 

14. Leave the remaining fields in the Data Processor Properties window as their default values, and 1172 
click Apply.  1173 

15. Click OK to close the window. 1174 
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Set LogRhythm-XDR for System Monitor 1175 

1. Back in the LogRhythm console, navigate to the Deployment Manager tab in the menu ribbon. 1176 

2. Navigate to System Monitors on the Deployment Manager menu ribbon. 1177 

3. Double-click LogRhythm-XDR. 1178 
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4. In the System Monitor Agent Properties window, navigate to Syslog and Flow Settings. 1179 

5. Click the checkbox beside Enable Syslog Server. 1180 

6. Click OK to close the System Monitor Agent Properties window. 1181 

 

Use the LogRhythm Web Console 1182 

1. Open a web browser, and navigate to https://localhost:8443. 1183 
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2. Enter the Username: logrhythmadmin 1184 

3. Enter the Password: ********** 1185 

 

2.2.3.4 LogRhythm NetworkXDR 1186 

LogRhythm NetworkXDR paired with LogRhythm XDR enables an environment to monitor network 1187 
traffic between end points and helps suggest remediation techniques for identified concerns. This 1188 
project utilizes NetworkXDR for continuous visibility on network traffic between HDO VLANs and 1189 
incoming traffic from the telehealth platform provider. 1190 

System Requirements 1191 

CPU: 24 vCPUs 1192 

Memory: 64 GB RAM 1193 

Storage: 1194 
 Operating System Hard Drive: 220 GB 1195 
 Data Hard Drive: 3 TB 1196 
 Operating System: CentOS 7 1197 

 1198 

Network Adapter: VLAN 1348 1199 

LogRhythm NetworkXDR Installation 1200 

LogRhythm provides an International Organization for Standardization (.iso) disk image to simplify 1201 
installation of NetMon. The .iso is a bootable image that installs CentOS 7.7 Minimal and NetMon. Note: 1202 
Because this is an installation on a Linux box, there is no need to capture the screenshots. 1203 
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Download the Installation Software 1204 

1. Open a new tab in the web browser, and navigate to https://community.logrhythm.com. 1205 

2. Log in using the appropriate credentials. 1206 

3. Click LogRhythm Community. 1207 

4. Navigate to Documentation & Downloads. 1208 

5. Register a Username. 1209 

6. Click Accept. 1210 

7. Click Submit. 1211 

8. Navigate to NetMon. 1212 

9. Click downloads: netmon4.0.2. 1213 

10. Select NetMon ISO under Installation Files. 1214 

Install LogRhythm NetworkXDR 1215 

1. In the host server, mount the .iso for the installation. 1216 

2. Start the VM with the mounted .iso. 1217 

3. When the welcome screen loads, select Install LogRhythm Network Monitor. 1218 

4. The installer completes the installation, and the system reboots. 1219 

5. When the system reboots, log in to the console by using logrhythm as the login and ****** as 1220 
the password. 1221 

6. Then change the password by typing the command passwd, type the default password, and 1222 
then type and verify the new password. 1223 

LogRhythm NetworkXDR Configuration 1224 
 1225 

1. Data Process Address: 192.168.45.20 1226 

2. Click Apply. 1227 

https://community.logrhythm.com/
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3. Click the Windows Service tab. 1228 

4. Change the Service Type to Automatic. 1229 

5. Click Apply. 1230 
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6. Click the Log File tab. 1231 

7. Click Refresh to ensure NetworkXDR log collection.  1232 

8. Click OK to exit the Local Configuration Manager. 1233 
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2.2.3.5 LogRhythm System Monitor Agent 1234 

LogRhythm System Monitor Agent is a component of LogRhythm XDR that receives end-point log files 1235 
and machine data in an IT infrastructure. The system monitor transmits ingested data to LogRhythm XDR 1236 
where a web-based dashboard displays any identified cyber threats. This project deploys LogRhythm’s 1237 
System Monitor Agents on end points in each identified VLAN. 1238 

Install the LogRhythm System Monitor Agent on one of the end points (e.g., Clinical Workstation) in the 1239 
HDO environment so that the LogRhythm XDR can monitor the logs, such as syslog and eventlog, of this 1240 
workstation. 1241 

System Monitor Agent Installation 1242 
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This section describes installation of the system monitor agent.  1243 

Download Installation Packages 1244 

1. Using a Clinical Workstation, open a web browser. 1245 

2. Navigate to https://community.logrhythm.com. 1246 

3. Log in using the credentials made when installing and configuring LogRhythm XDR. 1247 

4. Navigate to LogRhythm Community. 1248 

5. Click Documents & Downloads. 1249 

6. Click SysMon. 1250 

7. Click SysMon – 7.4.10. 1251 

8. Click Windows System Monitor Agents, and save to the Downloads folder on the Workstation. 1252 

Install System Monitor Agent 1253 

1. On the Workstation, navigate to Downloads folder. 1254 

2. Click LRWindowsSystemMonitorAgents. 1255 

3. Click LRSystemMonitor_64_7. 1256 

4. On the Welcome page, follow the Wizard, and click Next…. 1257 

 
 

https://community.logrhythm.com/
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5. On the ready to begin installation page, click Install. 1258 

 

6. Click Finish. 1259 

 

System Monitor Agent Configuration 1260 

1. After exiting the LogRhythm System Monitor Service Install Wizard, a LogRhythm System 1261 
Monitor Local Configuration window displays. Under the General tab, provide the following 1262 
information: 1263 



SECOND DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 133 

a. Data Process Address: 192.168.45.20 1264 

b. System Monitor IP Address/Index: 192.168.45.20 1265 

2. Click Apply. 1266 

 

3. Click the Windows Service tab. 1267 

4. Change the Service Type to Automatic. 1268 

5. Click Apply. 1269 
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6. Click the Log File tab. 1270 

7. Click Refresh to ensure NetworkXDR log collection. 1271 

8. Click OK to exit the Local Configuration Manager. 1272 
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Add Workstation for System Monitor 1273 

Engineers added Clinical Workstation for System Monitor and Set Its Message Source Types in the 1274 
LogRhythm Deployment Manager. 1275 

1. Log in to the LogRhythm Console.  1276 

a. User ID: LogRhythmAdmin 1277 

b. Password: ********** 1278 
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2. Navigate to the Deployment Manager in the menu ribbon. 1279 
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 1280 

3. Under Entity Hosts, click on New. 1281 
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 1282 

4. Click New to open the Host pop-up window, and enter the following under the Basic 1283 
Information tab: 1284 

a. Name: ClinicalWS 1285 

b. Host Zone: Internal 1286 
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5. Navigate to the Identifiers tab, provide the following information in the appropriate fields, and 1287 
click Add. 1288 

a. IP Address: 192.168.44.251 1289 

b. Windows Name: clinicalws (Windows Name) 1290 
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6. Add the ClinicalWS as a new system monitor agent by navigating to the System Monitors tab, 1291 
right-clicking in the empty space, and selecting New. 1292 

7. In the System Monitor Agent Properties window, click the button next to Host Agent is Installed 1293 
on, and select Primary Site: ClinicalWS. 1294 
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8. Go to System Monitors. 1295 

9. Double-click ClinicalWS. 1296 

10. Under LogSource of the System Monitor Agent Property window, right-click in the empty space, 1297 
and select New. The Log Message Source Property window will open. 1298 

11. Under the Log Message Source Property window, click the button associated with Log Message 1299 
Source Type. It will open the Log Source Selector window. 1300 

12. In the text box to the right of the Log Source Selector window, type XML, and click Apply. 1301 

13. Select the Log Source Type, and click OK. 1302 
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2.2.4 Data Security 1303 

Data security controls align with the NIST Cybersecurity Framework’s PR.DS category. For this practice 1304 
guide, the Onclave Networks solution was implemented as a component in the simulated patient home 1305 
and simulated telehealth platform provider cloud environment. The Onclave Networks suite of tools 1306 
provides secure communication between the two simulated environments when using broadband 1307 
communications to exchange data.  1308 

2.2.4.1 Onclave SecureIoT 1309 

The Onclave SecureIoT deployment consists of six components: Onclave Blockchain, Onclave 1310 
Administrator Console, Onclave Orchestrator, Onclave Bridge, and two Onclave Gateways. These 1311 
components work together to provide secure network sessions between the deployed gateways. 1312 

Onclave SecureIoT Virtual Appliance Prerequisites 1313 

All Onclave devices require Debian 9.9/9.11/9.13. In addition, please prepare the following: 1314 

1. GitHub account. 1315 
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2. Request an invitation to the Onclave Github account. 1316 

Once the GitHub invitation has been accepted and a Debian VM has been installed in the virtual 1317 
environment, download and run the installation script to prepare the VM for configuration. 1318 

1. Run the command sudo apt-get update 1319 

2. Run the command apt install git -y 1320 

3. Run the command sudo apt install openssh-server 1321 

4. Run the command git clone 1322 
https://readonly:Sh1bboleth45@gitlab.onclave.net/onclave/build/install.git   1323 

5. Navigate to the /home/onclave/install directory. 1324 

6. Run the command chmod +x *.sh 1325 

This process can be repeated for each virtual appliance that is deployed. The following guidance 1326 
assumes the system user is named onclave. 1327 

Onclave SecureIoT Blockchain Appliance Information 1328 

CPU: 4 1329 

RAM: 8 GB 1330 

Storage: 120 GB (Thick Provision) 1331 

Network Adapter 1: VLAN 1317 1332 

Operating System: Debian Linux 9.11 1333 

Onclave SecureIoT Blockchain Appliance Configuration Guide 1334 

Before starting the installation script, prepare an answer for each question. The script will configure the 1335 
server, assign a host name, create a self-signed certificate, and start the required services. 1336 

1. Run the command nano/etc/hosts 1337 

a. Edit the Hosts file to include the IP address and domain name of each Onclave device, 1338 
as well as Onclave’s docker server. This will include: 1339 

i. 192.168.5.11 tele-adco.trpm.hclab 1340 

ii. 192.168.5.12 tele-orch.trpm.hclab 1341 

iii. 192.168.5.13 tele-bg.trpm.hclab 1342 



SECOND DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 144 

iv. 192.168.5.14 tele-gw1.trpm.hclab 1343 

v. 192.168.21.10 tele-gw2.trpm.hclab 1344 

vi. 38.142.224.131 docker.onclave.net 1345 

2. Save the file and exit. 1346 

3. Navigate to the /home/onclave/install directory. 1347 

4. Run the command ./go.sh and fill out the following information: 1348 

a. What type of device is being deployed?: bci 1349 

b. Enter device hostname (NOT FQDN): tele-bci 1350 

c. Enter device DNS domain name: trpm.hclab 1351 

d. Enter the public NIC: ens192 1352 

e. Enter the private NIC, if does not exist type in NULL: NULL 1353 

f. Enter the IP Settings (DHCP or Static): PUBLIC NIC (Static) 1354 

i. address 192.168.5.10 1355 

ii. netmask 255.255.255.0 1356 

iii. gateway 192.168.5.1 1357 

iv. dns-nameservers 192.168.1.10 1358 

g. What is the BCI FQDN for this environment?: tele-bci.trpm.hclab 1359 

h. Enter the Docker Service Image Path: NULL 1360 

i. Will system need TPM Emulator? (yes/no): no 1361 

j. Keystore/Truststore password to be used?: Onclave56 1362 

k. GitLab Username/Password (format username:password): readonly:Sh1bboleth45 1363 

5. Wait for the Blockchain server to reboot. 1364 

6. Login to the appliance. 1365 

7. Run the command su root and enter the password. 1366 

8. Wait for the configuration process to finish. 1367 

Onclave SecureIoT Administrator Console Appliance Information 1368 
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CPU: 4 1369 

RAM: 8 GB 1370 

Storage: 32 GB (Thick Provision) 1371 

Network Adapter 1: VLAN 1317 1372 

Operating System: Debian Linux 9.11 1373 

Onclave SecureIoT Administrator Console Appliance Configuration Guide 1374 

1. Run the command scp onclave@192.168.5.10:/home/onclave/blockchain/certs/tele-1375 
bci.trpm.hclab.crt /root/certs 1376 

2. Run the command nano/etc/hosts 1377 

a. Edit the Hosts file to include the IP address and domain name of each Onclave device, 1378 
as well as Onclave’s docker server. This will include: 1379 

i. 192.168.5.10 tele-bci.trpm.hclab 1380 

ii. 192.168.5.12 tele-orch.trpm.hclab 1381 

iii. 192.168.5.13 tele-bg.trpm.hclab 1382 

iv. 192.168.5.14 tele-gw1.trpm.hclab 1383 

v. 192.168.21.10 tele-gw2.trpm.hclab 1384 

vi. 38.142.224.131 docker.onclave.net 1385 

b. Save the file and exit. 1386 

3. Navigate to the /home/onclave/install directory. 1387 

4. Run the command chmod +x *.sh 1388 

5. Run the command ./go.sh and fill out the following information: 1389 

a. What type of device is being deployed?: adco 1390 

b. Enter device hostname (NOT FQDN): tele-adco 1391 

c. Enter device DNS domain name: trpm.hclab 1392 

d. Enter the public NIC: ens192 1393 

e. Enter the private NIC, if does not exist type in NULL: NULL 1394 
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f. Enter the IP Settings (DHCP or Static): PUBLIC NIC (Static) 1395 

i. address 192.168.5.11 1396 

ii. netmask 255.255.255.0 1397 

iii. gateway 192.168.5.1 1398 

iv. dns-nameservers 192.168.1.10 1399 

g. What is the BCI FQDN for this environment?: tele-bci.trpm.hclab 1400 

h. Enter the Docker Service Image Path: NULL 1401 

i. Will system need TPM Emulator? (yes/no): yes 1402 

j. Keystore/Truststore password to be used?: Onclave56 1403 

k. GitLab Username/Password (format username:password): readonly:Sh1bboleth45 1404 

6. Wait for the Administrator Console server to reboot. 1405 

7. Login to the appliance. 1406 

8. Run the command su root and enter the password. 1407 

9. Wait for the configuration process to finish. 1408 

10. Navigate to the /home/onclave directory. 1409 

11. Run the command docker pull docker.onclave.net/orchestrator-service:1.1.0 1410 

12. Run the command docker pull docker.onclave.net/bridge-service:1.1.0 1411 

13. Run the command docker pull docker.onclave.net/gateway-service:1.1.0 1412 

Administrator Console Initialization and Bundle Creation 1413 

1. Using a web browser, navigate to https://tele-adco.trpm.hclab. 1414 

2. Click Verify. 1415 

3. Provide the following information: 1416 

a. Software ID (provided by Onclave) 1417 

b. Password (provided by Onclave) 1418 

c. PIN (provided by Onclave) 1419 

4. Provide the following information to create a superuser account: 1420 
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a. First Name: ***** 1421 

b. Last Name: ***** 1422 

c. Username: *****@email.com 1423 

d. Password: ******** 1424 

e. Organization Name: NCCoEHC 1425 

5. Click Software Bundles. 1426 

6. Click the plus symbol (top right), and provide the following information: 1427 

a. Bundle name: nccoe-tele-orch 1428 

b. Bundle type: Orchestrator 1429 

c. Owned by: NCCoEHC 1430 

d. Orchestrator owner name: HCLab 1431 

e. PIN: **** 1432 

f. Password: ******** 1433 

7. Click Create. 1434 

8. Click the plus symbol (top right), and provide the following information: 1435 

a. Bundle name: nccoe-tele-bg 1436 

b. Bundle type: Bridge 1437 

c. Owned by: NCCoEHC 1438 

9. Click Create. 1439 

10. Click the plus symbol (top right), and provide the following information: 1440 

a. Bundle name: nccoe-tele-gw 1441 

b. Bundle type: Gateway 1442 

c. Owned by: NCCoEHC 1443 

11. Click Create. 1444 

Transfer Ownership of Onclave Devices to the Orchestrator 1445 
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Once each Onclave device has been created and provisioned, it will show up in the Admin Console’s web 1446 
GUI. From here, the devices can be transferred to the Orchestrator with the following steps: 1447 

1. Using a web browser, navigate to https://tele-adco.trpm.hclab. 1448 

2. Click Devices. 1449 

3. Select the checkbox next to tele-bg, tele-gw1, and tele-gw2. 1450 

4. Click Transfer ownership. 1451 

5. Under Select a new owner, select HCLab. 1452 

6. Click Transfer ownership. 1453 

Onclave SecureIoT Orchestrator Appliance Information 1454 

CPU: 4 1455 

RAM: 8 GB 1456 

Storage: 32 GB (Thick Provision) 1457 

Network Adapter 1: VLAN 1317 1458 

Operating System: Debian Linux 9.11 1459 

Onclave SecureIoT Orchestrator Appliance Configuration Guide 1460 

1. Run the command scp onclave@192.168.5.10:/home/onclave/blockchain/certs/tele-1461 
bci.trpm.hclab.crt /root/certs 1462 

2. Run the command nano/etc/hosts 1463 

a. Edit the Hosts file to include the IP address and domain name of each Onclave device, as 1464 
well as Onclave’s docker server. This will include: 1465 

i. 192.168.5.10 tele-bci.trpm.hclab 1466 

ii. 192.168.5.11 tele-adco.trpm.hclab 1467 

iii. 192.168.5.13 tele-bg.trpm.hclab 1468 

iv. 192.168.5.14 tele-gw1.trpm.hclab 1469 

v. 192.168.21.10 tele-gw2.trpm.hclab 1470 

vi. 38.142.224.131 docker.onclave.net 1471 

b. Save the file and exit. 1472 
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3. Run the command nano /etc/network/interfaces 1473 

a. Edit the Interfaces file to include: 1474 

i. iface ens192 inet static 1475 

1. address 192.68.5.12 1476 

2. netmask 255.255.255.0 1477 

3. gateway 192.168.5.1 1478 

4. dns-nameservers 192.168.1.10 1479 

b. Save the file and exit. 1480 

4. Run the command git clone https://github.com/Onclave-Networks/orch.git 1481 

5. Navigate to the /home/onclave/orch directory. 1482 

6. Run the command chmod +x *.sh 1483 

7. Run the command ./go.sh and fill out the following information: 1484 

a. What will be the hostname for your orchestrator?: tele-orch 1485 

b. What will be the domain name for your orchestrator?: trpm.hclab 1486 

c. Enter the deviceʼs public NIC: ens192 1487 

d. What is the Blockchain environment?: tele-bci 1488 

e. Will system need TPM Emulator? (yes/no): yes 1489 

f. What is the docker image for the Orchestrator Service?: docker.onclave.net/orchestrator-1490 
service:1.1.0- nccoe-tele-orch 1491 

8. Reboot the Orchestrator server. 1492 

9. Using a web browser, navigate to https://tele-orch.trpm.hclab. 1493 

10. Click Verify. 1494 

11. Provide the following information (created when making the bundle in the Admin Console): 1495 

a. Software ID 1496 

b. Password 1497 

c. PIN 1498 
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12. Provide the following information to create a superuser account: 1499 

a. First Name: ***** 1500 

b. Last Name: ***** 1501 

c. Username: *****@email.com 1502 

d. Password: ******** 1503 

e. Organization Name: Telehealth Lab 1504 

Create a Customer in the Orchestrator 1505 

1. Using a web browser, navigate to https://tele-orch.trpm.hclab. 1506 

2. Click Customers. 1507 

3. Click the plus symbol. 1508 

4. Under Attributes > Customer Name, enter Telehealth Lab. 1509 

5. Click Create. 1510 

Create a Secure Enclave 1511 

Once each Onclave device has been transferred to the Orchestrator, it will show up in the Orchestrator’s 1512 
web GUI. From here, the secure enclave can be created with the following steps: 1513 

1. Using a web browser, navigate to https://tele-orch.trpm.hclab. 1514 

2. Click Secure Enclaves. 1515 

3. Click the plus symbol. 1516 

4. Under General, provide the following information: 1517 

a. Secure Enclave name: TeleHealth Secure Enclave 1518 

b. Customer: Telehealth Lab 1519 

c. Sleeve ID: 51 1520 

5. Under Subnets, provide a Network Address (CIDR notation) of 192.168.50.0/24. 1521 

6. Under Session Key, provide a Lifespan (minutes) of 60.  1522 

 1523 

7. Click Create. 1524 
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Prepare the Bridge for Inclusion in the Secure Enclave 1525 

1. Using a web browser, navigate to https://tele-orch.trpm.hclab. 1526 

2. Click Devices. 1527 

3. Select the bridge, and provide the following information: 1528 

a. Device Name: tele-bg 1529 

b. Customer: Telehealth Lab 1530 

c. Secure Enclaves: Not assigned to any Secure Enclave 1531 

d. State: Orchestrator Acquired 1532 

e. Secure tunnel port number: 820  1533 

f. Private interface IP address undefined: checked 1534 

4. Click Save. 1535 

Prepare the Telehealth Gateway for Inclusion in the Secure Enclave 1536 

1. Using a web browser, navigate to https://tele-orch.trpm.hclab. 1537 

2. Click Devices. 1538 

3. Select the bridge, and provide the following information: 1539 

a. Device Name: tele-gw1 1540 

b. Customer: Telehealth Lab 1541 

c. Secure Enclaves: Not assigned to any Secure Enclave 1542 

d. State: Orchestrator Acquired 1543 

e. Secure tunnel port number: 820  1544 

f. Private interface IP address undefined: checked 1545 

4. Click Save. 1546 

Prepare the Home Gateway for Inclusion in the Secure Enclave 1547 

1. Using a web browser, navigate to https://tele-orch.trpm.hclab. 1548 

2. Click Devices. 1549 

3. Select the bridge, and provide the following information: 1550 
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a. Device Name: tele-gw2 1551 

b. Customer: Telehealth Lab 1552 

c. Secure Enclaves: Not assigned to any Secure Enclave 1553 

d. State: Orchestrator Acquired 1554 

e. Secure tunnel port number: 820  1555 

f. Private interface IP address undefined: checked 1556 

4. Click Save. 1557 

Establish the Secure Enclave 1558 

Once the secure enclave has been created and each Onclave device has been configured with a name 1559 
and customer, the secure enclave can be established with the following steps: 1560 

1. Using a web browser, navigate to https://tele-orch.trpm.hclab. 1561 

2. Click Secure Enclaves. 1562 

3. Click the edit symbol for the previously created secure enclave. 1563 

4. Under Topology, click Add a Bridge. 1564 

5. Select tele-bg. 1565 

6. Click Add. 1566 

7. Click Add a Gateway. 1567 

8. Select tele-gw1. 1568 

9. Click Add. 1569 

10. Click Add a Gateway. 1570 

11. Select tele-gw2. 1571 

12. Click Add. 1572 

13. Under Topology Controls, toggle on Approve topology. 1573 

14. Click Save Changes. 1574 

15. Click Devices. 1575 

16. Refresh the Devices page until each device is labeled as Topology Approved. 1576 
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17. Click Secure Enclaves. 1577 

18. Click the edit symbol for the previously created secure enclave. 1578 

19. Under Topology, toggle on Trust All Devices. 1579 

20. Click Save Changes. 1580 

21. Click Devices. 1581 

22. Refresh the Devices page until each device is labeled as Secured. 1582 

Onclave SecureIoT Bridge Appliance Information 1583 

CPU: 4 1584 

RAM: 8 GB 1585 

Storage: 32 GB (Thick Provision) 1586 

Network Adapter 1: VLAN 1317 1587 

Network Adapter 2: VLAN 1319 1588 

Operating System: Debian Linux 9.11 1589 

Onclave SecureIoT Bridge Appliance Configuration Guide 1590 

1. Run the command scp onclave@192.168.5.10:/home/onclave/blockchain/certs/tele-1591 
bci.trpm.hclab.crt /root/certs 1592 

2. Run the command nano /etc/hosts 1593 

a. Edit the Hosts file to include the IP address and domain name of each Onclave device, 1594 
as well as Onclave’s docker server. This will include: 1595 

i. 192.168.5.10 tele-bci.trpm.hclab 1596 

ii. 192.168.5.11 tele-adco.trpm.hclab 1597 

iii. 192.168.5.12 tele-orch.trpm.hclab 1598 

iv. 192.168.5.14 tele-gw1.trpm.hclab 1599 

v. 192.168.21.10 tele-gw2.trpm.hclab 1600 

vi. 38.142.224.131 docker.onclave.net 1601 

3. Run the command nano /etc/network/interfaces 1602 
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a. Edit the Interfaces file to include: 1603 

i. iface ens192 inet static 1604 

1. address 192.68.5.13 1605 

2. netmask 255.255.255.0 1606 

3. gateway 192.168.5.1 1607 

4. dns-nameservers 192.168.1.10 1608 

ii. iface ens224 inet static 1609 

b. Save the file and exit. 1610 

4. Run the command git clone https://github.com/Onclave-Networks/bridge.git 1611 

5. Navigate to the /home/onclave/bridge directory. 1612 

6. Run the command chmod +x *.sh 1613 

7. Run the command ./go.sh 1614 

a. What will be the hostname for your bridge?: tele-bg 1615 

b. What will be the domain name for your bridge?: trpm.hclab 1616 

c. Enter the deviceʼs public NIC: ens192 1617 

d. Enter the device’s private NIC: ens224 1618 

e. What is the Blockchain environment?: tele-bci 1619 

f. Will system need TPM Emulator? (yes/no): yes 1620 

g. What is the docker image for the Bridge Service?: docker.onclave.net/bridge-1621 
service:1.1.0- nccoe-tele-bg 1622 

8. Reboot the Bridge server. 1623 

Onclave SecureIoT Telehealth Gateway Appliance Information 1624 

CPU: 2 1625 

RAM: 8 GB 1626 

Storage: 16 GB  1627 

Network Adapter 1: VLAN 1317 1628 
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Network Adapter 2: VLAN 1349 1629 

Operating System: Debian Linux 9.11 1630 

Onclave SecureIoT Telehealth Gateway Appliance Configuration Guide 1631 

1. Run the command scp onclave@192.168.5.10:/home/onclave/blockchain/certs/tele-1632 
bci.trpm.hclab.crt /root/certs 1633 

2. Run the command nano /etc/hosts 1634 

a. Edit the Hosts file to include the IP address and domain name of each Onclave device, 1635 
as well as Onclave’s docker server. This will include: 1636 

i. 192.168.5.10 tele-bci.trpm.hclab 1637 

ii. 192.168.5.11 tele-adco.trpm.hclab 1638 

iii. 192.168.5.12 tele-orch.trpm.hclab 1639 

iv. 192.168.5.13 tele-bg.trpm.hclab 1640 

v. 192.168.21.10 tele-gw2.trpm.hclab 1641 

vi. 38.142.224.131 docker.onclave.net 1642 

3. Run the command nano /etc/network/interfaces 1643 

a. Edit the Interfaces file to include: 1644 

i. iface enp3s0 inet static 1645 

1. address 192.168.5.14 1646 

2. netmask 255.255.255.0 1647 

3. gateway 192.168.5.1 1648 

4. dns-nameservers 192.168.1.10 1649 

ii. iface ens224 inet dhcp 1650 

b. Save the file and exit. 1651 

4. Run the command git clone https://github.com/Onclave-Networks/gateway.git 1652 

5. Navigate to the /home/onclave/gateway directory. 1653 

6. Run the command chmod +x *.sh 1654 
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7. Run the command ./go.sh 1655 

a. What will be the hostname for your gateway?: tele-gw1 1656 

b. What will be the domain name for your gateway?: trpm.hclab 1657 

c. Enter the deviceʼs public NIC: enp3s0 1658 

d. Enter the deviceʼs private NIC: enp2s0 1659 

e. What is the Blockchain environment?: tele-bci 1660 

f. Will system need TPM Emulator? (yes/no): no 1661 

g. What is the docker image for the Gateway Service?: docker.onclave.net/ gateway-1662 
service:1.1.0- nccoe-tele-gw 1663 

8. Reboot the Gateway server. 1664 

Onclave SecureIoT Home Wi-Fi Gateway Appliance Information 1665 

CPU: 1 1666 

RAM: 4 GB 1667 

Storage: 16 GB 1668 

Network Adapter 1: VLAN 1332 1669 

Network Adapter 2: VLAN 1350 (Wi-Fi) 1670 

Operating System: Debian Linux 9.11 1671 

Onclave SecureIoT Home Wi-Fi Gateway Appliance Configuration Guide 1672 

1. Run the command scp onclave@192.168.5.10:/home/onclave/blockchain/certs/tele-1673 
bci.trpm.hclab.crt /root/certs 1674 

2. Run the command nano /etc/hosts 1675 

a. Edit the Hosts file to include the IP address and domain name of each Onclave device, 1676 
as well as Onclave’s docker server. This will include: 1677 

i. 192.168.5.10 tele-bci.trpm.hclab 1678 

ii. 192.168.5.11 tele-adco.trpm.hclab 1679 

iii. 192.168.5.12 tele-orch.trpm.hclab 1680 

iv. 192.168.5.13 tele-bg.trpm.hclab 1681 
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v. 192.168.5.14 tele-gw1.trpm.hclab 1682 

vi. 38.142.224.131 docker.onclave.net 1683 

3. Run the command nano /etc/network/interfaces 1684 

a. Edit the Interfaces file to include: 1685 

i. iface enp3s0 inet static 1686 

1. address 192.168.21.10 1687 

2. netmask 255.255.255.0 1688 

3. gateway 192.168.21.1 1689 

4. dns-nameservers 192.168.1.10 1690 

ii. iface br0 inet static 1691 

1. bridge_ports br51 wlp5s0 1692 

iii. iface wlp5s0 inet manual 1693 

b. Save the file and exit. 1694 

4. Run the command git clone https://github.com/Onclave-Networks/hostapd-29.git 1695 

5. Navigate to the /home/onclave/hostapd-29 directory. 1696 

6. Run the command chmod +x *.sh 1697 

7. Run the command ./hostapd-29.sh 1698 

8. Navigate to the /home/onclave directory. 1699 

9. Run the command git clone https://github.com/Onclave-Networks/hostapd-client.git 1700 

10. Navigate to the /home/onclave/hostapd-client directory. 1701 

11. Run the command chmod +x *.sh 1702 

12. Run the command ./hostapd-client.sh 1703 

13. Navigate to the /home/onclave directory. 1704 

14. Run the command git clone https://github.com/Onclave-Networks/gateway.git 1705 

15. Navigate to the /home/onclave/gateway directory. 1706 

16. Run the command chmod +x *.sh 1707 
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17. Run the command ./go.sh 1708 

a. What will be the hostname for your gateway?: tele-gw2 1709 

b. What will be the domain name for your gateway?: trpm.hclab 1710 

c. Enter the deviceʼs public NIC: enp3s0 1711 

d. Enter the deviceʼs private NIC: wlp5s0 1712 

e. What is the Blockchain environment?: tele-bci 1713 

f. Will system need TPM Emulator? (yes/no): no 1714 

g. What is the docker image for the Gateway Service?: docker.onclave.net/ gateway-1715 
service:1.1.0- nccoe-tele-gw 1716 

18. Reboot the Gateway server. 1717 
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Appendix A List of Acronyms 1718 

AD Active Directory 

CPU Central Processing Unit  

DC Domain Controller 

DHCP Dynamic Host Configuration Protocol 
DNS Domain Name Service 

FMC Firepower Management Center 

FTD Firepower Threat Defense 

GB Gigabyte 

HDO Healthcare Delivery Organization 

HIS Health Information System 
IP Internet Protocol 

ISO International Organization for Standardization 

IT Information Technology 

NAT Network Address Translation 

NCCoE National Cybersecurity Center of Excellence 

NIST National Institute of Standards and Technology 
OVA Open Virtual Appliance or Application 

PACS Picture Archiving and Communication System 

RAM Random Access Memory 

RPM Remote Patient Monitoring 

SFC Stealthwatch Flow Collector 

SIEM Security Incident Event Management 
SMC Stealthwatch Management Center 

SP Special Publication 

TB Terabyte 

URL Uniform Resource Locator 

vCPU Virtual Central Processing Unit 

VLAN Virtual Local Area Network 
VM Virtual Machine 

XDR Extended Detection and Response 
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